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AKVIS DRAW 10.0 | СОЗДАНИЕ КАРАНДАШНОГО ЭСКИЗА

AKVIS Draw превращает фотографии в графические эскизы и карандашные наброски.

Эскизы, созданные программой, копируют технику настоящего рисунка.

Программа  AKVIS Draw проста в использовании, она превращает фотографию в рисунок одним щелчком мыши.
Откройте изображение и настройте параметры, чтобы получить набросок карандашом. Программа творчески создает
карандашные штрихи, имитируя технику и видение художника.

Оснащенная готовыми пресетами и настраиваемыми параметрами эффекта, программа имитирует различные стили
рисования и позволяет создавать черно-белые наброски и рисунки цветными карандашами. Функционал AKVIS Draw
предоставляет неисчерпаемые возможности для творчества.
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Программа предлагает быстрый и удобный способ превращения фотографии в рисунок. Результат автоматического
преобразования может соперничать с работой настоящего художника. Можно  редактировать рисунок с помощью
инструментов Ластик и Карандаш: убрать или смягчить линии, добавить дополнительные штрихи.

Придайте изображению вид рисунка ручной работы с помощью AKVIS Draw!
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Создавайте потрясающие дополнительные эффекты, соединяя исходное изображение и результат. Экспериментируя с
режимами наложения, попробуйте  "проявить" фотографию сквозь рисунок. Вы можете придать изображению вид
комикса или добиться эффекта акварельного карандаша. С помощью инструментов зонирования можно ограничить
область эффекта и получить впечатляющее сочетание рисунка и фотографии.
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Чтобы сделать рисунок еще более впечатляющим, переключитесь в раздел Оформление (Холст/Рамка/Надпись) и
поместите изображение на текстурную поверхность, оформите в рамку и добавьте свою подпись на произведение
искусства.

Программа  поддерживает  Пакетную обработку файлов, что позволяет обработать множество фотографий в
автоматическом режиме и создать целый альбом набросков или подготовить раскадровку.

AKVIS Draw можно использовать для создания авторского эскиза или как один из этапов для подготовки
художественного произведения, в сочетании с другими программами AKVIS: ArtWork, OilPaint, Pastel, Charcoal и др.
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AKVIS Draw представлен в виде обычной программы (standalone) и в виде плагина для графических редакторов (plugin).
Тип лицензии определяет доступные возможности.

- Standalone — автономная программа, которая запускается и функционирует обычным способом.

- Plugin — дополнительный фильтр, который подключается к AliveColors и другим совместимым графическим редакторам.

Воспользуйтесь ознакомительным периодом, чтобы попробовать все возможности программы и создать свою коллекцию
уникальных рисунков!
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УСТАНОВКА НА WINDOWS

Следуйте инструкции, чтобы установить программу AKVIS на Windows.

Для установки программы необходимо обладать правами администратора.

Перед установкой плагина необходимо закрыть графический редактор, в который будет устанавливаться плагин. Если
установка плагина была выполнена при запущенном графическом редакторе, то его необходимо перезапустить.

 

1. Запустить программу установки двойным щелчком по файлу exe.
2. Выбрать язык программы и нажать на кнопку Установить (Install).
3. Ознакомиться с  Лицензионным Соглашением, при согласии с его условиями выбрать пункт "Я принимаю

условия лицензионного соглашения" ("I accept the term in the license agreement") и нажать на кнопку Далее
(Next).

4. Для установки  плагина нужно выбрать из списка графический редактор (или редакторы), в который будет
устанавливаться плагин.

Для установки  версии standalone (отдельной программы) должен быть выбран соответствующий вариант —
Standalone.
Для создания ярлыка программы на рабочем столе должен быть выбран компонент  Ярлык на рабочий стол
(Desktop Shortcut).

Нажать на кнопку Далее (Next).
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5. Нажать кнопку Установить (Install).

6. Запустится процесс установки программы.

7. Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, ссылки на обучающие
статьи и специальные предложения. Для этого введите свой адрес e-mail и подтвердите согласие с политикой
конфиденциальности.
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8. Нажать кнопку Готово (Finish) для выхода из программы инсталляции.

После установки программы AKVIS Draw в главном меню Start (Пуск) появится пункт AKVIS -> Draw, a на рабочем
столе — ярлык программы AKVIS Draw (если при установке было выбрано создание ярлыка).

После установки  плагина Draw в меню фильтров (эффектов) редактора появится новый пункт  AKVIS – Draw.
Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop: Filter -> AKVIS ->
Draw, в AliveColors: Эффекты -> AKVIS -> Draw.

Внимание! Если плагин не установился в графический редактор автоматически, можно подключить его вручную. 
Обычно достаточно просто скопировать файл 8bf из папки AKVIS в папку Plug-ins графического редактора. Например,
для Adobe Photoshop CC скопируйте 8bf в папку Program Files\Common Files\Adobe\Plug-Ins\CC. 
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УСТАНОВКА НА MAC

Следуйте инструкции, чтобы установить программу AKVIS на Mac.

Для установки программы необходимо обладать правами администратора.

 

1. Открыть виртуальный диск dmg:

- akvis-draw-app.dmg для установки версии Standalone (отдельной программы)

- akvis-draw-plugin.dmg для установки версии Plugin.

2. Ознакомиться с Лицензионным соглашением и нажать кнопку Agree.

3. Откроется окно Finder с приложением AKVIS Draw (в случае установки отдельной программы) или, в случае
установки плагина, с папкой AKVIS Draw Plugin.

 

Для установки версии standalone приложение AKVIS Draw переместить в папку Applications.

Для установки версии  plugin приложение  AKVIS Draw Plugin перенести в папку с плагинами графического
редактора:

AliveColors: любая папка, указанная в настройках редактора,

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC,

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins,

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-Ins.
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Плагины на Mac
(кликните на изображение для увеличения)

После установки плагина Draw в меню фильтров (эффектов) редактора появится новый пункт AKVIS –> Draw.
Используйте эту команду для вызова плагина из графического редактора. Например, в  Photoshop: Filter ->
AKVIS -> Draw, в AliveColors: Эффекты -> AKVIS -> Draw.

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.

Также можно запустить программу AKVIS из приложения  Фото,  выбрав команду  Изображение ->
Редактировать в (в High Sierra и более поздних версиях macOS).
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УСТАНОВКА НА LINUX

Примечание: Программы AKVIS совместимы только с  64-битным ядром Linux версии 5.x или более поздней.
Узнать версию ядра можно с помощью команды uname -srm.

 

Инструкция для установки на Linux программы

 

Установка в системах на основе Debian (например, Astra Linux).

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Создать каталог для хранения ключей:

sudo mkdir -p /usr/share/keyrings 

3. Скачать ключ, которым подписан репозиторий:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

или

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Добавить репозиторий в список, где система ищет пакеты для установки: 

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com
akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Обновить список известных пакетов:

sudo apt-get update 

6. Начать установку программы AKVIS Draw:

sudo apt-get install akvis-draw 

7. Установка завершена.

Запустить AKVIS Draw через терминал или ярлык программы.

8. Для автоматического обновления используется команда:

sudo apt-get upgrade 

для удаления программы:

sudo apt-get remove akvis-draw --autoremove 

 

Установка в системах на основе RPM (например, РЕД ОС).

1. Запустить терминал.
2. Зарегистрировать ключ, которым подписан репозиторий

sudo rpm --import https://akvis.com/akvis.asc 

3. Добавить репозиторий в систему

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Обновить список пакетов

при использовании менеджера пакетов dnf:

sudo dnf update 

при использовании менеджера пакетов yum:

sudo yum update 

5. Установить программу AKVIS Draw

AKVIS Draw
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при использовании менеджера пакетов dnf:

sudo dnf install akvis-draw 

при использовании менеджера пакетов yum:

sudo yum install akvis-draw 

6. Установка завершена.

Запустить AKVIS Draw через терминал или ярлык программы.

7. Для автоматического обновления

при использовании менеджера пакетов dnf:

sudo dnf upgrade 

при использовании менеджера пакетов yum:

sudo yum upgrade 

8. Для удаления программы

при использовании менеджера пакетов dnf:

sudo dnf remove akvis-draw 

при использовании менеджера пакетов yum:

sudo yum remove akvis-draw 

 

Установка в системе ALT Linux.

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Войти как root-пользователь:

su - 

3. Добавить репозиторий в систему:

apt-get install akvis-repo 

4. Обновить список известных пакетов:

apt-get update 

5. Установить программу AKVIS Draw:

apt-get install akvis-draw 

6. Установка завершена.

Запустить AKVIS Draw через терминал или ярлык программы.

7. Для автоматического обновления используется команда:

apt-get dist-upgrade 

для удаления программы:

apt-get remove akvis-draw 

 

Установка в системе openSUSE.

1. Запустить терминал.
2. Войти как root-пользователь.
3. Добавить ключ, которым подписан репозиторий

rpm --import http://akvis.com/akvis.asc 
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4. Добавить репозиторий в систему

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Обновить список пакетов:

zypper ref 

6. Установить программу AKVIS Draw:

zypper install akvis-draw 

7. Установка завершена.

Запустить AKVIS Draw через терминал или ярлык программы.

8. Для автоматического обновления используется команда:

zypper update 

для удаления программы:

zypper remove akvis-draw 

 

Установка с помощью Flatpak.

1. Запустить терминал.
2. Добавить репозиторий Flathub:

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

3. Добавить репозиторий AKVIS:

sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Установить программу AKVIS Draw:

sudo flatpak install -y akvis com.akvis.akvis-draw 

5. Установка завершена.

Запустить AKVIS Draw через ярлык программы или терминал

flatpak run com.akvis.akvis-draw 

6. Для обновления всех установленных флатпаков используется команда:

sudo flatpak update -y 

для удаления программы:

sudo flatpak remove -y com.akvis.draw 

 

Для правильного отображения интерфейса программы рекомендуется установить композитный менеджер Compton или
Picom.
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АКТИВАЦИЯ ПРОГРАММЫ

Внимание! Ваш компьютер должен быть подключен к сети Интернет.

Если подключение к Интернет недоступно, ниже предлагается альтернативный способ активации.

 

Скачать установочный файл AKVIS Draw (на странице программы или на странице загрузки).

Запустить скачанный файл и установить программу, следуя подсказкам мастера установки.

Запустить установленную программу. Окно  О программе всегда показывается при запуске незарегистрированной
копии программы. Кроме того, окно О программе выводится при нажатии кнопки   на Панели управления программы.

При работе с плагином в редакторе Adobe Photoshop окно О программе может быть вызвано на экран выбором
команды меню Help -> About Plug-In –> Draw на Windows, Photoshop -> About Plug-In –> Draw на Mac.

 

При нажатии кнопки Попробовать откроется окно, где можно выбрать тип лицензии для ознакомления. Если пробный
период истёк, кнопка будет неактивна.

В течение ознакомительного периода (10 дней) доступна любая лицензия: Home (Plugin либо Standalone), Deluxe или
Business. При выборе лицензии рядом будет отображен пояснительный текст с кратким описанием данного типа
лицензии. В зависимости от выбора будут доступны разные возможности AKVIS Draw.

Для получения более полной информации о версиях и лицензиях программы AKVIS Draw смотрите  сравнительную
таблицу.

 

При нажатии кнопки Купить будет открыто окно, где необходимо указать приобретаемый тип лицензии.

После выбора лицензии необходимо снова нажать кнопку Купить. В браузере откроется страница заказа, где можно
продолжить подбор программ либо приступить к оформлению покупки.

После заполнения формы и проведения денежной транзакции серийный номер будет выслан в течение нескольких
минут.

 

Чтобы зарегистрировать программу, нажать на кнопку Активировать. Откроется следующее окно:
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В поле Имя пользователя ввести имя, на которое будет зарегистрирована программа.

Внимание! Длина имени пользователя на кириллице не должна превышать 21 символ.

В поле Серийный номер ввести номер, полученный после оплаты заказа.

Ниже выбрать способ активации - через прямое соединение с сервером или через электронную почту.

Прямое соединение с сервером

Рекомендуется данный способ активации, как наиболее быстрый.

Компьютер должен быть подключен к сети Интернет.

Нажать на кнопку Активировать для завершения активации.

Отправить запрос по e-mail

Eсли был выбран способ активации через e-mail, то при нажатии на кнопку Активировать будет автоматически
создано письмо, которое, не редактируя, необходимо отправить по указанному адресу.

Если компьютер не подключен к Интернет, нужно записать созданное письмо на внешний носитель (диск или
"флешку") и отправить с другого компьютера, на котором есть доступ к сети. Все, что нам нужно, уже будет
записано в самом письме.

Если письмо не создается, просто пришлите нам серийный номер (код лицензии) программы и HardwareID (HWID)
компьютера, на котором установлена программа.

В ответ будет получено письмо с вложенным файлом Draw.lic, который следует поместить в папку, где хранится
лицензионная информация о программе. Это папка AKVIS в Общих документах пользователей:

Windows:

C:\Users\Public\Documents\AKVIS;

Mac:

/Users/Shared/AKVIS или домашняя папка пользователя;

Linux:

/var/lib/AKVIS.

Активация программы завершена.

AKVIS Draw

18

https://akvis.com/ru/support/feedback.php?utm_source=help


 

При желании можно произвести апгрейд до версии Home Deluxe или Business, доплатив разницу в цене. Для этого в
окне О программе необходимо нажать кнопку Улучшить (в зарегистрированной версии появляется на месте кнопки
Купить).

В открывшемся окне выбрать желаемую лицензию и нажать кнопку  Улучшить. При этом в браузере откроется
страница заказа, где можно оплатить выбранный апгрейд.

После оплаты вы получите сообщение, что ваша лицензия обновлена, после чего потребуется переактивировать
программу.

При нажатии кнопки Отменить происходит возврат в окно О программе.

При возникновении вопросов или проблем обратитесь в службу поддержки - support@akvis.com.

 

ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ

Программа AKVIS Draw может работать как отдельная программа или как плагин к графическому редактору.

Запустить отдельную программу можно обычным способом.

Для вызова плагина необходимо открыть изображение в редакторе, а затем выбрать пункт AKVIS –> Draw из
меню фильтров.

Вид рабочей области зависит от выбора режима редактирования на Панели управления: Параметры или Пресеты.

В режиме параметров откроется стандартное окно программы.

Рабочая область программы AKVIS Draw

Кнопка Пресеты позволяет переключиться в режим визуального отображения пресетов (см. Галерея пресетов).

Галерея пресетов
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Элементы окна программы:

Центральную часть окна программы AKVIS Draw занимает Окно изображения с двумя закладками До и  После.  В
закладке До показано исходное изображение, в закладке После – изображение после обработки. Переключаться
между ними можно щелчком левой кнопки мыши по названию закладки. Временно переключиться на другую закладку
можно с помощью клика левой или правой кнопки мыши по изображению: пока кнопка удерживается нажатой, будет
показана противоположная закладка.

 

В верхней части окна расположена Панель управления с кнопками:

Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Draw.

Кнопка   (только в отдельной программе) предназначена для открытия изображения. Открыть изображение

можно с помощью горячих клавиш Ctrl+O  на Windows, ⌘ +O  на Mac.
При щелчке правой кнопкой мыши будет показан список последних использованных файлов, сортированных по
времени открытия. Длина списка задаётся в окне изменения настроек программы.

Кнопка   (только в отдельной программе) предназначена для сохранения отредактированного изображения на

диск. Диалог сохранения файла вызывается также нажатием клавиш Ctrl+S  на Windows, ⌘ +S  на Mac.
Кнопка   (только в отдельной программе) предназначена для вывода изображения на печать. Быстрая отправка

на печать производится нажатием клавиш Ctrl+P  на Windows, ⌘ +P  на Mac.
Кнопка   предназначена для загрузки из файла сохраненных ранее пресетов.

Кнопка   предназначена  для записи пресетов в отдельный файл с расширением  .draw. В файл можно

сохранить любое количество пресетов.
Кнопка   (только в отдельной программе) вызывает диалоговое окно пакетной обработки фотографий.

Кнопка   /  включает и отключает показ контуров зонирования.

Кнопка   предназначена для отмены последнего действия. Если нажать на эту кнопку несколько раз, будут

отменены несколько последних действий. Отменить действие можно с клавиатуры при помощи комбинации клавиш
Ctrl+Z  на Windows, ⌘ +Z  на Mac.
Кнопка   позволяет восстановить действие, отмененное командой  . Восстановить действие можно с

клавиатуры, использовав сочетание клавиш Ctrl+Y  на Windows, ⌘ +Y  на Mac.
Кнопка   запускает процесс обработки изображения с учётом заданных параметров. Результат будет показан в

закладке После.

Кнопка   (только в плагине) предназначена для применения результатов и закрытия окна программы AKVIS

Draw.

Кнопка   предназначена для вызова сведений о программе.

Кнопка   предназначена для вызова справки помощи по программе. Окно помощи вызывается также нажатием

кнопки F1 .

Кнопка   вызывает диалог изменения настроек программы.

Кнопка   вызывает панель оповещений со свежими новостями о программе.

 

Слева от  Окна изображения находится  Панель инструментов. Параметры инструмента будут показаны в окне,
всплывающем по щелчку правой кнопки мыши.

Инструменты предварительной обработки (для работы на закладке До):

Кнопка   (только в отдельной программе) активирует инструмент  Кадрирование. С помощью данного

инструмента можно отсечь часть изображения, оставив нужный фрагмент.

 

Инструменты зонирования:

Область эффекта . Синими линиями на изображении отмечаются участки, которые будут превращены в

рисунок.
Запретить обработку . Красными линиями отмечаются области изображения, которые не будут

преобразованы в рисунок и останутся в исходном состоянии.
Кнопка   активирует инструмент Ластик, с помощью которого можно стереть контуры зонирования.

Инструменты постобработки (для доработки изображения на закладке После):
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Кнопка   активирует инструмент  Карандаш, предназначенный для рисования произвольных линий. Цвет

карандаша указан в параметрах инструмента.
Кнопка   активирует инструмент Ластик, предназначенный для стирания карандашных штрихов.

Кнопка   активирует инструмент Кисть возврата. Инструмент позволяет восстановить изменённые участки

изображения (доступен только для лицензии Home Deluxe и Business).

Вспомогательные инструменты (общие для всех режимов):

Кнопка   активирует инструмент Рука, который позволяет прокручивать фотографию, когда она не помещается

в Окне изображения при выбранном масштабе. Для прокрутки необходимо нажать на кнопку, подвести курсор к
изображению и, удерживая левую кнопку мыши нажатой, переместить в нужную сторону.
Двойным щелчком по кнопке   изображение масштабируется под размер окна программы.

Кнопка   активирует инструмент  Лупа, предназначенный для изменения масштаба изображения. Для

увеличения масштаба необходимо щёлкнуть левой кнопкой мыши по изображению в окне программы. Для
уменьшения масштаба изображения щелчок производится с нажатой клавишей  Alt . Для быстрого вызова
инструмента используется клавиша Z .

Двойным щелчком по кнопке   можно развернуть изображение в натуральную величину (100%).

Результат изменения параметров можно наблюдать в  Окне предварительного просмотра на закладке  До.
Перемещение по изображению и масштабирование осуществляется с помощью Навигатора. Рамкой в Навигаторе
отмечается та часть изображения, которая в данный момент является видимой в Окне изображения; области за
пределами рамки будут затенены. Рамку можно перетаскивать, меняя видимую часть изображения. Для перемещения
рамки необходимо поместить курсор внутрь рамки и, удерживая левую кнопку мыши, выполнить перетаскивание.

Навигатор

Масштабировать изображение в Окне изображения можно с помощью ползунка. При перемещении ползунка вправо
происходит увеличение масштаба изображения, при перемещении влево - уменьшение.

Для прокрутки изображения в Окне изображения можно использовать полосы прокрутки или нажать на пробел и
перетаскивать изображение левой кнопкой мыши. Прокруткой колёсика мыши изображение можно перемещать вверх-
вниз, удерживая Ctrl  – вправо-влево, удерживая Alt  − масштабировать. При щелчке правой кнопкой мыши на полосе
прокрутки появляется меню быстрых перемещений.

Также масштаб изображения изменится, если ввести в поле масштабирования новый масштабный коэффициент. Часто
используемые масштабы помещены в выпадающее меню поля масштабирования.

Для увеличения масштаба изображения можно воспользоваться клавиатурными сокращениями: +  и Ctrl++  (⌘ ++  на
Mac), для уменьшения масштаба -  и Ctrl+-  (⌘ +-  на Mac).

Текущее значение масштаба продублировано на нижней полосе прокрутки в Окне изображения.

Под Навигатором расположена Панель настроек с закладками Рисунок и Оформление.

В закладке Рисунок задаются параметры конвертации изображения в набросок.
В закладке Оформление можно отрегулировать параметры подписи к рисунку, добавить холст и рамку.

Панель Пресеты предназначена для работы с группами настроек. Текущие настройки программы можно сохранять,
изменять и удалять. При запуске программы параметры конвертации будут выставлены в соответствии с настройками
выбранного пресета.

Внизу выводится подсказка: краткое описание параметров и кнопок, на которые наводится курсор. Подсказки можно
разместить на Панели настроек, под Окном просмотра или отключить совсем, в зависимости от выбора опции в окне
Настроек программы.
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РАБОТА С ПРОГРАММОЙ

AKVIS Draw может работать как отдельная программа или как плагин к графическому редактору.
Возможности программы зависят от  типа лицензии. Во время ознакомительного периода можно попробовать все
варианты и выбрать наиболее подходящий.

Для того чтобы преобразовать фотографию в карандашный набросок, необходимо выполнить следующие действия:

Шаг 1. Открыть изображение.

- В отдельной программе (файл в формате TIFF, BMP, RAW, JPEG, WEBP или PNG):

Диалоговое окно  Открыть изображение можно вызвать сразу после запуска программы с помощью
двойного щелчка мыши в области Окна изображения или кнопкой   на Панели управления. Кроме

того, можно перетащить ярлык изображения в открытое окно программы или редактора.

- При работе с плагином:

В графическом редакторе с помощью команды меню Файл -> Открыть или сочетания клавиш  Ctrl+O  на
Windows, ⌘ +O  на Mac вызвать диалог открытия изображения и выбрать требуемый файл.

Вызвать плагин AKVIS Draw:

в AliveColors: Effects -> AKVIS -> Draw;
в Adobe Photoshop: Filter –> AKVIS –> Draw;
в Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Draw;
в Corel Photo-Paint: Effects –> AKVIS –> Draw.

Вид рабочей области зависит от выбора режима редактирования на  Панели управления: Параметры или
Пресеты.

Окно программы AKVIS Draw

Шаг 2. В отдельной программе перед применением эффекта можно использовать инструмент Кадрирование 

для удаления ненужных частей изображения. Настройки инструмента будут показаны на Панели настроек.

Чтобы отсечь области, не попавшие в кадр, следует нажать  OK или клавишу  Enter . Если нужно отменить
операцию - кнопку Отмена или  Esc . Чтобы вернуть область кадрирования к исходному состоянию, достаточно
выбрать кнопку Сброс.
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Кадрирование изображения
Шаг 3. Отрегулировать значения параметров эффекта на Панели настроек.

В режиме Автозапуска любое изменение настроек автоматически запускает процесс обработки изображения.
Автозапуск можно отключить в Настройках программы. При работе в обычном режиме обработка запускается
кнопкой  . Результат преобразования будет показан на закладке После.

Нажатие кнопки Отмена справа от индикатора процесса обработки прерывает расчёт.

Результат обработки

Для обработки отдельных областей используется разметка с помощью синих и красных линий.
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Без доработки Использован ластик

 

Штриховая разметка

Область эффекта . Синими линиями на изображении отмечаются участки, которые будут превращены в

рисунок.
Запретить обработку . Красными линиями отмечаются области изображения, которые не будут

преобразованы в рисунок и останутся в исходном состоянии.
Ластик . С помощью данного инструмента можно частично или полностью стереть контуры зонирования.

Режим стирания выбирается опционально:

- Стирать все штрихи;
- Стирать только красные штрихи;
- Стирать только синие штрихи.

Толщину штрихов и размер ластика можно изменить в окне настроек инструмента (всплывает по щелчку правой
кнопки мыши).

Шаг 4. Полученное изображение можно доработать на закладке После с помощью инструментов Карандаш ,

Ластик  и Кисть возврата . Параметры инструментов будут показаны в окне, всплывающем по щелчку

правой кнопки мыши.

Цвет карандаша указан в параметрах инструмента. Задать цвет можно с помощью пипетки (один клик по
квадрату) или системного диалога (двойной клик по квадрату).

Внимание! Если параметры эффекта изменены и выполняется новый расчёт, результат доработки будет
потерян.

Инструмент Кисть возврата  доступен только для лицензии Home Deluxe и Business.

Шаг 5. При необходимости настроить в закладке Оформление параметры  холста, рамки или добавить  текст.
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Порядок применения эффектов зависит от последовательности, в которой расположены закладки.

Оформление рисунка
Шаг 6. Понравившиеся настройки конвертации  можно сохранить как  пресет и использовать в дальнейшем.
Пресет является общим для всех закладок.

Рядом с названием пресета находится пиктограмма сердечка  / . Щелчком по ней можно добавить выбранный

пресет в Избранное.

Дополнительная информация о пресетах Draw.

Шаг 7. В стандалон-версии AKVIS Draw есть возможность распечатать изображение.
Шаг 8. Сохранить изображение.

- В отдельной программе:

Нажать на кнопку   и в диалоговом окне Сохранить изображение ввести имя файла, указать формат

(TIFF, BMP, JPEG, WEBP или PNG) и выбрать каталог, в который необходимо сохранить файл.

- При работе с плагином:

Нажать на кнопку  , чтобы применить результат обработки. Окно плагина  AKVIS Draw закроется, и

изображение появится в окне графического редактора.

Вызвать диалог сохранения файла командой меню Файл -> Сохранить как, ввести имя файла, указать
формат и выбрать каталог, в который необходимо сохранить файл.
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Рисунок
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КАРАНДАШНЫЙ НАБРОСОК (ПАРАМЕТРЫ ЗАКЛАДКИ РИСУНОК)

На Панели настроек задаются параметры конвертации изображения в набросок карандашом.

Фотография, преобразованная в карандашный эскиз

 

Варианты работы с цветом:

Одноцветный рисунок. Рисунок будет выполнен одним карандашом. Цвет линий и фона задаётся в квадратах
(по умолчанию чёрно-белый).

Для изменения текущего цвета необходимо дважды кликнуть по квадрату и выбрать цвет из стандартного
диалога. Щёлчком по квадрату вызывается инструмент Пипетка.

Кнопка   сбрасывает цвета до дефолтных значений. При нажатии кнопки   цвет линий и фона поменяется

местами.

Яркие штрихи. Карандашный рисунок в более насыщенных оттенках цвета. В этом режиме можно менять цвет
фона.
Натуральные оттенки. Многоцветный рисунок с сохранением исходной цветовой гаммы. Изображение рисуется
на белом фоне.

Внимание! Использование цвета доступно только для лицензий Home Deluxe и Business.
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Яркие штрихи Натуральные оттенки

Одноцветный рисунок
Варианты раскраски с изменением цвета линий и фона

 

Параметры эффекта:

В выпадающем списке Режим наложения можно задать способ смешивания рисунка с исходным изображением.
Степень смешивания регулируется параметром Непрозрачность.

Внимание! Данная возможность доступна только для лицензии Home Deluxe и Business.
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Непрозрачность = 10 Непрозрачность = 85

Обычные штрихи
(Чек-бокс выключен)

Штрихи с тонкими концами
(Чек-бокс активен)

Режим Умножение, Непрозрачность = 54

Чек-бокс Тонкие концы изменяет внешний вид штрихов. При включении чек-бокса концы линий утончаются.
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Без дополнительного контраста
(Чек-бокс выключен)

Дополнительный контраст
(Чек-бокс активен)

Яркость = 20 Яркость = 90

Детализация = 30 Детализация = 80

Чек-бокс Дополнительный контраст позволяет сильнее выделить границы в тёмных областях.

Яркость (10-100). Интенсивность цвета линий (от бледного до насыщенного).

Детализация (10-100). Количество прорисованных деталей.
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Толщина линий = 5 Толщина линий = 25

Плотность штриховки = 50 Плотность штриховки = 150

Чувствительность = 30 Чувствительность = 70

Толщина линий (3-30). Ширина штрихов.

Плотность штриховки (0-200). Число фоновых штрихов, используемых для передачи объёма.

Чувствительность (0-80). Интенсивность проявления линий. Чем выше уровень чувствительности, тем больше
штрихов образуется на изображении.
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Изогнутость = 0 Изогнутость = 10

Разброс = 20 Разброс = 85

Микродетали = 0 Микродетали = 900

Изогнутость (0-12). Степень искривления штрихов под влиянием градиентов. Чем больше параметр, тем сильнее
выражен изгиб линий штриховки. При значении 0 штрихи будут прямыми.

Разброс (1-100). Изменение структуры штриховки. Линии становятся мелкими и тонкими, добавляется
хаотичность.

Микродетали (0-1000). Число небольших тёмных линий, дополняющих контур рисунка.

Яркость границ (1-100). Интенсивность проявления границ.
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Яркость границ = 10 Яркость границ = 90

Тени = 1 Тени = 30

Шум = 0 Шум = 70

Чек-бокс Дополнительные эффекты:

Тени (0-50). На изображении появляются более глубокие тени.

Шум (0-100). Параметр придает изображению зернистости.

Контраст (-100..100). Усиление разницы между яркими и тёмными участками изображения.
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Контраст = -15 Контраст = 45
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ДОБАВЛЕНИЕ ХОЛСТА

В программе AKVIS Draw можно поместить изображение на подложку (любой материал или поверхность - различные
виды бумаги, ткани, покрытие).

Для этого на закладке Оформление нужно выбрать закладку Холст и включить чек-бокс Создать основу.

Подсказка: Порядок применения эффектов  Холст/Рамка/Надпись зависит от последовательности, в которой
расположены закладки.

Использование холста

Текстура выбирается из Библиотеки текстур, которая поставляется в комплекте с программой. Для загрузки своей
текстуры выберите пункт <Пользовательская>....

Настройка параметров холста.
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ДОБАВЛЕНИЕ РАМКИ

В программе AKVIS Draw можно оформить край изображения рамкой или виньеткой.

Для этого на закладке Оформление нужно выбрать закладку Рамка и включить одноименный чек-бокс.

Подсказка: Порядок применения эффектов  Холст/Рамка/Надпись зависит от последовательности, в которой
расположены закладки.

Закладка 'Рамка'

 

Тип рамки выбирается в выпадающем списке:

Классическая рамка
Узор
Штрихи
Виньетка
Паспарту
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НАДПИСЬ (ПАРАМЕТРЫ ЗАКЛАДКИ)

В программе AKVIS Draw можно добавить поверх изображения текстовую фразу (например, подпись или название) или
водяной знак.

Для этого на закладке Оформление нужно выбрать закладку Надпись и включить один из двух чек-боксов: Надпись
или Изображение.

Подсказка: Порядок применения эффектов  Холст/Рамка/Текст зависит от последовательности, в которой
расположены закладки.

Добавление надписи

Настройка параметров надписи.
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РАБОТА С ПРЕСЕТАМИ

Программа AKVIS Draw позволяет сохранить понравившиеся настройки обработки как пресет и использовать их в
дальнейшем.

При перемещении курсора по списку готовых пресетов в маленьком окне просмотра будет показан примерный
результат обработки.

Пресеты могут содержать параметры всех закладок. Если настройки были изменены, вернуть их можно кнопкой Сброс.

Для сохранения настроек необходимо на Панели настроек (справа) в поле Пресеты ввести имя пресета и нажать на
кнопку Сохранить.

Для удаления пресета необходимо выбрать его в списке и нажать на кнопку Удалить.

 

Рядом с названием пресета находится пиктограмма сердечка  / . Щелчком по ней можно добавить выбранный

пресет в Избранное.

 

Галерея пресетов

Кнопка Пресеты позволяет переключиться в режим визуального отображения пресетов.
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Галерея пресетов

Если изображение ещё не загружено в программу, вы увидите список пресетов, отсортированный по алфавиту (пресеты
AKVIS) или по дате создания (свои пресеты). Для загруженных изображений формируются миниатюры.

Щёлкните по пресету один раз, чтобы выбрать его, и дважды, чтоб запустить расчёт для всей картинки.

Пользовательские пресеты можно переименовать двойным кликом по названию пресета.

Показом элементов списка управляют три кнопки:

 − будут показаны Пресеты AKVIS; 

 − будут показаны Пользовательские пресеты; 

 − будут показаны пресеты из группы Избранное (отмечены сердечком).

Миниатюры с эффектом можно расположить двумя способами:

 − объединить в вертикальную колонку (Список); 

 − заполнить всю область программы (Галерея).

Кнопки управления пресетами дублируются командами контекстного меню:

/  − добавить или удалить из Избранного;

 − переименовать пресет (пресеты AKVIS переименовать нельзя!);

 − удалить пресет;

 − переместить вверх;

 − переместить вниз;

 − показать параметры пресета.

Пресеты можно сохранить в отдельный файл с расширением  .draw. Для записи пресетов в файл нажмите  . Для

загрузки пресетов из файла нажмите  .

Более подробно об импорте и экспорте пресетов.
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НАСТРОЙКИ ПРОГРАММЫ

Диалог изменения настроек программы вызывается кнопкой   и имеет вид:

Язык программы. Для переключения интерфейса программы на другой язык необходимо выбрать язык из
выпадающего списка.
Масштаб интерфейса. В списке можно выбрать размер элементов интерфейса. При выборе значения  Авто
масштаб интерфейса автоматически подстраивается под разрешение экрана.
Интерфейс. В выпадающем списке можно выбрать стиль оформления программы - светлый или тёмный.
Масштаб изображения при загрузке. Возможны следующие варианты:

- изображение масштабируется Под размер окна. Масштаб подгоняется так, чтобы оно было полностью
видимым в Окне изображения; 
- при значении параметра 100% изображение не масштабируется. В большинстве случаев при открытии в
масштабе 100% в окне программы будет показана лишь часть изображения.

Последние открытые файлы. Количество файлов, отображаемых в списке недавно открытых документов при
правом клике мышью по кнопке   (сортированы по времени открытия). Максимальная длина списка - 30

файлов.
Отображение подсказок. В данном блоке задаётся местоположение окна подсказок.

- Слева под окном изображения;
- Справа на панели настроек;
- Не отображать.

Чек-бокс  Автозапуск. В режиме автозапуска любое изменение настроек автоматически запускает процесс
обработки. При работе в обычном режиме обработка запускается после нажатия кнопки  .

Чек-бокс  Закрепить панель управления блокирует возможность сворачивания панели. Разблокированную
панель можно сворачивать и разворачивать щелчком по маленькой треугольной стрелке. Свёрнутая панель
всплывает при наведении курсора.

Для принятия изменений в окне Настройки нажмите ОК.

При необходимости можно вернуть исходные значения параметров, нажав на кнопку По умолчанию.
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ПАКЕТНАЯ ОБРАБОТКА ФОТОГРАФИЙ

В программе  AKVIS Draw существует возможность редактирования фотографий с помощью пакетной обработки
файлов.

 
Процесс обработки пакета фотографий

 

Подробная инструкция по работе с отдельной программой находится здесь.

Узнать о работе с плагином можно по ссылке.
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ПАКЕТНАЯ ОБРАБОТКА В ПЛАГИНАХ AKVIS

Плагины AKVIS можно использовать при редактировании серии фотографий с помощью пакетной обработки файлов
(batch processing).

При пакетной обработке с помощью плагина требуется вначале создать экшен (action), а затем применить его в Adobe
Photoshop к папке с фотографиями.

Пакетная обработка может быть очень полезна и сэкономит много времени, если для редактирования серии фотографий
требуется к каждой из них применить плагин с одними и теми же настройками.

Шаг 1. Вначале необходимо создать две папки, например, "source-files" и "result-files". В папку "source-files"
поместить все фотографии,  нуждающиеся в обработке.  В папку "resu l t - f i les"  будут сохраняться
отредактированные фотографии.
Шаг 2. Открыть в редакторе Adobe Photoshop одну из исходных фотографий. Она нужна для подбора параметров
к плагину и создания экшена.

Одна из фотографий
Шаг 3. Открыть палитру Actions и щелкнуть по кнопке Create New Set. В появившемся диалоговом окне задать
имя для нового набора экшенов − к примеру, AKVIS.

Палитра Actions в Photoshop
Шаг 4. Теперь необходимо записать новый экшен. Нажать на кнопку  Create New Action и в появившемся
диалоговом окне задать имя для нового экшена − например, Oil.
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Создание нового экшена

После нажатия на кнопку Record экшен сразу же начнет записываться.

AKVIS Draw

44



Шаг 5. Вызвать плагин и подобрать оптимальные параметры.

Окно плагина с выбранными параметрами

Шаг 6. Нажать на кнопку  . Окно плагина закроется, в окне редактора появится отредактированная

фотография, а в палитре Actions в экшене добавится строчка с названием плагина.

Шаг 7. Экшен всё ещё записывается. Теперь необходимо сохранить отредактированную фотографию в папку
"result-files". Для этого выбрать в меню File команду Save As.
Шаг 8. Остановить запись экшена, нажав на кнопку Stop playing/recording внизу палитры Actions.

Запись экшена остановлена
Шаг 9. Удалить из папки "result-files" только что сохраненный туда файл.
Шаг 10. Экшен создан, теперь можно переходить к пакетной обработке фотографий. В меню  File редактора
выбрать команду Automate -> Batch.
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Шаг 11. В появившемся окне Batch задать все данные и настройки.
В поле Set выбрать пункт "AKVIS", а в поле Action − название экшена.
Поле  Source служит для указания источника изображений. Выбрать пункт  Folder, который в качестве
источника позволяет указать определенную папку. Нажать на кнопку Choose и выбрать папку "source-files".
Поскольку команда открытия файла не записывалась в экшен, то чек-бокс  Override Action "Open"
Commands должен быть выключен.
В поле Destination выбрать пункт Folder, затем нажать на кнопку Choose и выбрать папку "result-files".
Отметить чек-бокс Override Action "Save as" Commands.
В разделе File Naming задается структура создания имен для обработанных файлов. Чтобы имена файлов
не изменялись, в первом поле следует выбрать  Document Name, а во втором поле − расширение
(еxtension).

Шаг 12. После нажатия OK редактор Adobe Photoshop друг за другом обработает все фотографии из папки
"source-files" и сохранит их в папку "result-files".
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ

Режим  Печать отвечает за подготовку изображений к распечатке на принтере. Перейти в режим печати можно
нажатием кнопки   на Панели управления.

Режим печати

Настроить печать выбранной фотографии можно с помощью параметров на Панели настроек:

В первом блоке из списка доступных принтеров выбрать нужный и указать необходимое разрешение, а также
задать количество печатных копий.

В блоке  Ориентация страницы задать положение листа при печати:  Альбомная  -  лист  расположен
горизонтально или Книжная - лист расположен вертикально.

При нажатии на кнопку Параметры страницы открывается диалоговое окно, в котором можно выбрать размер и
ориентацию бумаги при печати, а также задать ширину полей печати.

Нажатием кнопки Сброс полей можно вернуть полям страницы исходные размеры.

В следующем блоке можно настроить размер изображения для печати с помощью параметров Масштаб, Ширина,
Высота и Под размер страницы. Они не влияют на изображение, а только на его печатную копию. Изменить
размер печатной копии можно либо указав  Масштаб изображения в %, либо задав новые значения для
параметров Ширина и Высота.

Чтобы распечатать изображение во всю страницу, следует выбрать чек-бокс Под размер страницы. Если чек-
бокс неактивен, то положение картинки можно задать с помощью стрелок справа или перетаскиванием мышью.

В блоке Рамка можно задать ширину и цвет рамки вокруг изображения.

В блоке Цветной фон с помощью цветовой пластины можно вызвать стандартный диалог выбора цвета и задать
цвет страницы.

В закладке  Страница можно настроить расположение одной или нескольких копий изображения на одной
странице.
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Печать страницы
С помощью параметра Копии указать количество копий обработанной фотографии на одной странице.
Параметрами  По горизонтали  и   По вертикали задать количество строк и столбцов для размещения
фотографий.
С помощью параметра Отступ задать ширину отступа между копиями фотографий.

На вкладке Постер можно настроить печать одного изображения на нескольких страницах для последующего
объединения в одно большое полотно.

Печать постера
Чек-бокс Страницы. При активном чек-боксе в поле справа можно задать количество страниц, на которое
будет поделена фотография. Масштаб изображения изменится, чтобы максимально заполнить все страницы.
При неактивном - программа автоматически подберет оптимальное число листов в соответствии с
фактическим размером изображения (масштаб = 100%).
Чек-бокс Поля для клея. При активном чек-боксе в поле справа можно задать ширину отступов для
склеивания листов. Отступы будут оставлены с правого и нижнего краев при печати страницы.
Чек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан номер ее
позиции в столбце и строке.
Чек-бокс Линии отреза. При активном чек-боксе на полях страниц будут напечатаны линии, по которым
можно отрезать лишние части распечатанных листов.
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Для печати изображения с учетом настроенных параметров нажать на кнопку Печать. Для выхода из режима печати
нажать на кнопку Отмена.

При нажатии кнопки  Опции... будет открыт системный диалог, где можно произвести расширенную настройку и
отправить документ на печать.
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ГАЛЕРЕЯ РИСУНКОВ

Предлагаем вашему вниманию галерею работ, выполненных пользователями с помощью  AKVIS Draw. Все рисунки
получены из фотографий и служат иллюстрацией возможностей программы.

 

Портрет девушки. Автор Сергей Максименко.

Исходное изображение Цветной рисунок

Середина лета. Автор Сергей Максименко.

Исходное изображение Цветной рисунок

Шахматы. Автор Сергей Максименко.
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Исходное изображение Чёрно-белый рисунок

Весёлый старичок. Автор Liu Hui-zeng.

Исходное изображение Цветной набросок

Динозавр. Автор Liu Hui-zeng.

Исходное изображение Цветной рисунок

Аромат ягод. Автор Liu Hui-zeng.

Исходное изображение Цветной рисунок
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ГАЛЕРЕЯ РИСУНКОВ II

Изображения на данной странице были преобразованы в быстрые карандашные эскизы с помощью AKVIS Draw. Если вы
хотите предоставить свои изображения для публикации, напишите нам!

Спортсменки
(открыть в большом размере)

Музыкант
(открыть в большом размере)
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Этническая красота
(открыть в большом размере);

Боди-арт
(открыть в большом размере);
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Мама и дочь
(открыть в большом размере)

Баскетболист
(открыть в большом размере)
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Пончики
(открыть в большом размере)

Лошадь
(открыть в большом размере)
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Друзья
(открыть в большом размере)

Красотка
(открыть в большом размере)
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Портрет
(открыть в большом размере)
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Исходное изображение Результат

ПОДРАЖАНИЕ ПОЭТАМ

Программа AKVIS Draw предоставляет огромные возможности для творчества. Даже не имея навыков рисования, из
любой фотографии можно создать рукотворный рисунок, выполненный в виде небрежного эскиза. Теперь вы можете
оформить свою веб-страничку красивыми картинками, которые дополнят текст или стихи лёгкими, словно
выхваченными из небытия образами. Подобные зарисовки часто делают художники или поэты на полях альбомов и
дневников.

Для примера создадим несколько иллюстраций к отрывку из Байрона.

Есть в пустыне родник, чтоб напиться,
Деревцо есть на лысом горбе,
В одиночестве певчая птица
Целый день мне поет о тебе.

Примечание: Чтобы объединить изображения в один коллаж, требуется графический редактор.

Шаг 1. Создать в редакторе новое изображение − пусть это будет чистый белый лист размером 800 на 1200
пикселов.
Шаг 2. С помощью инструмента Текст  начертать поэтические строки.
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Добавление текста
Шаг 3. Открыть изображение дерева.

Шаг 4. Вызвать плагин AKVIS Draw из меню фильтров (эффектов): Effects -> AKVIS -> Draw.

Подобрать параметры эффекта и запустить расчёт (кнопка  ). Лишние детали можно удалить Ластиком .
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Окно с настройками программы AKVIS Draw

Шаг 5. Применить результат нажатием кнопки  .

Теперь желательно удалить фон. Самый простой способ − инструментом Волшебная палочка щёлкнуть по белой
области и нажать Delete .

Скопировать дерево на заготовку со стихами.

Дерево (набросок)
Шаг 6. Аналогичным образом разместить на изображении птичку:
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Птичка (набросок)

и женский силуэт:
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Леди (набросок)

Примечание: Каждая картинка занимает отдельный слой, прозрачность которого можно менять.

Шаг 7. При желании доработать изображение в графическом редакторе.
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Черновик поэта
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ПРОГРАММЫ КОМПАНИИ АКВИС

 

AKVIS AirBrush — Эффект аэрографического рисунка

AKVIS AirBrush позволяет превратить фотографию в рисунок в технике  аэрография. Программа действует как
художественный фильтр, изменяя изображение и превращая его в аэрографический рисунок в соответствии с
выбранными настройками. Подробнее…

 

AKVIS Artifact Remover AI — Улучшение качества сжатых изображений JPEG

AKVIS Artifact Remover AI — программа для улучшения качества сжатых изображений. Программа использует
алгоритмы искусственного интеллекта для удаления артефактов сжатия JPEG и восстановления качества фотографий.
Включает 4 режима улучшения изображения, каждый из которых задействует уникальную нейронную сеть. Для
домашних пользователей доступна бесплатная версия. Для коммерческого использования необходима лицензия
Business. Подробнее…

 

AKVIS ArtSuite — Эффекты и рамки для фотографий

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий. ArtSuite содержит множество готовых
шаблонов и богатую Библиотеку образцов и текстур и позволяет получить практически бесконечное количество
вариантов эффектов. Подробнее…
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AKVIS ArtWork — Художественные стили и техники

AKVIS ArtWork имитирует художественные стили и техники живописи, создавая произведение искусства. В программе
представлены эффекты:  Масляная живопись, Акварель, Гуашь, Комикс, Перо и чернила, Линогравюра, Трафарет,
Пастель и Пуантилизм. Подробнее…

 

AKVIS Chameleon — Создание коллажей

AKVIS Chameleon — программа для создания коллажей, реалистичных и фантастических. Chameleon экономит время и
силы, так как не требует точного выделения объектов, автоматически сглаживает границы и подбирает цветовую гамму
"вставки" к цветам фона. Подробнее…
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AKVIS Charcoal — Превращение фотографии в рисунок углём и мелом

AKVIS Charcoal позволяет преобразовать фотографию в рисунок, выполненный углём и мелом. Изменяя цвета
материалов и бумаги, можно получить массу самых разнообразных эффектов, например, имитировать рисунок сангиной,
сепией и другие живописные техники. Подробнее…

 

AKVIS Coloriage AI — Раскрашивание черно-белых фотографий

AKVIS Coloriage AI — программа для раскрашивания черно-белых фотографий. Программа включает в себя
автоматическое раскрашивание изображений на основе искусственного интеллекта, а также метод ручной раскраски с
помощью цветных штрихов. Вдохните новую жизнь в старые семейные фотографии! Подробнее…

 

AKVIS Decorator — Замена текстуры и перекраска поверхности

AKVIS Decorator — программа для изменения поверхности объекта. Decorator позволяет заменить текстуру либо цвет
выбранного объекта. При наложении текстуры сохраняется объем, изгибы, тени исходного изображения. В программе
представлена богатая Библиотека текстур:  образцы поверхностей дерева, металла, камня, травы, тканей и др.
Подробнее…
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AKVIS Draw — Создание карандашного эскиза

AKVIS Draw позволяет превратить фотографию в эскиз, выполненный простым карандашом. Программа имитирует
видение и подход истинного художника. С помощью AKVIS Draw вы можете придать любому изображению вид быстрого
карандашного наброска. Подробнее…

 

AKVIS Enhancer — Фотокоррекция с усилением детализации

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. Программа позволяет
проявить детали в светлых и темных областях, улучшить резкость и контрастность изображения, добавить яркость,
отредактировать отдельные цветовые области. Программа работает в трех режимах: Улучшение деталей, Допечатная
обработка и Тоновая коррекция. Подробнее…

 

AKVIS Explosion — Эффекты разрушения и распада

AKVIS Explosion добавляет на фотографии эффекты разрушения. Программа позволяет распылить объект на осколки,
превратить часть изображения в россыпь летящих частиц, создать песчаную бурю, имитировать взрыв и другие
эффекты распада. Подробнее…
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AKVIS Frames — Готовые рамки для фотографий

AKVIS Frames — бесплатная программа для оформления фотографий. Программа предназначена для работы с пакетами
рамок AKVIS. Вы можете украсить свои снимки эксклюзивными стильными рамками! Подробнее…

 

AKVIS HDRFactory — Расширение динамического диапазона

AKVIS HDRFactory — программа для создания изображений с расширенным динамическим диапазоном (HDR) из одного
или нескольких снимков, а также для коррекции яркости, контрастности, насыщенности. HDRFactory наполнит жизнью
и цветом ваши фотографии! Подробнее…

 

AKVIS Inspire AI — Художественная стилизация изображений

AKVIS Inspire AI выполняет стилизацию изображений под различные образцы живописи. Эта программа на основе
искусственного интеллекта применяет на фотографию цветовую гамму и стиль выбранного произведения искусства,
создавая новый шедевр. Программа включает в себя галерею художественных стилей и позволяет загружать свои
образцы. Имитируйте стиль известных художников! Подробнее…
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AKVIS LightShop — Световые и звездные эффекты

AKVIS LightShop добавляет световые эффекты на изображение. С помощью программы можно создать любого вида и
формы свечения, добавить на фотографию лучи, ореолы, вспышки, молнии, блики на объекты, закат или фейерверк.
LightShop украсит снимок, оживит пейзаж, изменит время суток и погоду. Подробнее…

 

AKVIS Magnifier AI — Увеличивайте и улучшайте изображения

AKVIS Magnifier AI позволяет увеличить размер изображения и улучшить качество. Благодаря использованию
нейросетей программа обеспечивает многократное увеличение, до 800%, и создает изображения высокого разрешения.
Улучшайте разрешение фотографии, создавайте четкие изображения идеального качества, с отличной детализацией!
Подробнее…

 

AKVIS MakeUp — Ретушь портретных фотографий

AKVIS MakeUp — программа для исправления портретных фотографий. MakeUp улучшает портрет, устраняя мелкие
дефекты с поверхности кожи и придавая лицу сияние, чистоту и гладкость. Программа способна превратить обычный
снимок в фотографию с обложки, создать стильный образ и даже получить изображение в "высоком ключе".
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Подробнее…

 

AKVIS NatureArt — Природные явления на ваших фотографиях

AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления. В программу включены
эффекты: Дождь

 

AKVIS Neon — Рисунок светящимися линиями

AKVIS Neon превращает фотографию в яркий и необычный рисунок, выполненный светящимися линиями. Программа
предназначена для создания неоновых эффектов на изображении. Подробнее…
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AKVIS Noise Buster AI — Удаление цифрового шума

AKVIS Noise Buster AI — программа для подавления цифрового шума. Программа убирает шумы матрицы цифровой
камеры и шумы, появляющиеся при сканировании фотоснимка, уменьшает зернистость и устраняет неоднородные
цветовые пятна на изображении, сохраняя при этом детали и чёткость границ. Программа использует технологии
искусственного интеллекта и настройки постобработки для усовершенствования результата. Подробнее…

 

AKVIS OilPaint — Эффект масляной живописи

AKVIS OilPaint — программа для имитации масляной живописи. Особенностью программы является уникальный
алгоритм наложения мазков, который наиболее достоверно воспроизводит технику работы кистью. Подробнее…

 

AKVIS Pastel — Рисунок пастелью из фотографии

AKVIS Pastel позволяет преобразовать обычный фотоснимок в рисунок, выполненный пастелью. Программа превращает
любое изображение в произведение искусства, имитируя одну из самых популярных художественных техник,
обладающую графическими и живописными свойствами. Подробнее…
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AKVIS Points — Картины в технике пуантилизма

AKVIS Points превращает фотографии в картины в одной из самых выразительных живописных техник — пуантилизм. С
помощью программы Points вы с легкостью можете создавать великолепные произведения искусства в манере
пуантилистов. Откройте для себя мир ярких красок! Подробнее…

 

AKVIS Refocus AI — Улучшение фокусировки, эффекты размытия

AKVIS Refocus AI повышает резкость нечетких фотографий, предлагает полную и выборочную фокусировку, добавляет
эффекты размытия и боке. Программа работает в пяти режимах:  Исправление фокуса AI, Миниатюра, Размытие
диафрагмы, Размытие движения и Радиальное размытие. Подробнее…

 

AKVIS Retoucher — Восстановление и ретушь фотографий

AKVIS Retoucher — программа для восстановления изображений и ретуши фотографий.

Программа поможет удалить царапины, пятна, пыль, следы от сгибов и другие дефекты; убрать лишние детали, текст;
реконструировать недостающие части фотографии, "затянуть" дырявые места и нарастить оборванные края.
Подробнее…
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AKVIS Sketch — Рисунок карандашом из фотографии

AKVIS Sketch — программа для создания рисунка из фотографии. Программа превращает фотоснимки в эскизы,
сделанные карандашом или углем, позволяет создать черно-белый карандашный набросок или цветной рисунок. В
программе представлены следующие стили:  Классический, Художественный, Маэстро  и   Мультистиль, — каждый с
набором готовых пресетов. AKVIS Sketch позволяет каждому почувствовать себя художником! Подробнее…

 

AKVIS SmartMask AI — Выделение объекта и удаление фона

AKVIS SmartMask AI — эффективная программа для выделения объекта на изображении. Оснащенная инструментами
искусственного интеллекта, эта программа представляет собой быстрый и удобный способ выделять объекты и удалять
фон. SmartMask AI позволяет избавиться от трудоемкого и скучного аспекта работы и полностью посвятить себя
творчеству и реализации идей. Подробнее…

 

AKVIS Watercolor — Рисунок акварельными красками

AKVIS Watercolor превращает фотографию в акварельный рисунок. Программа включает в себя два стиля:
Классическая акварель  и   Контурная акварель, каждый с набором готовых пресетов. Создавайте произведения
искусства в технике акварельной живописи! Подробнее…
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